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 Important Information

Warranty
The National Instruments VXI-1394 board is warranted against defects in materials and workmanship for a period of one year from 
the date of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace 
equipment that proves to be defective during the warranty period. This warranty includes parts and labor.

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, 
due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other 
documentation. National Instruments will, at its option, repair or replace software media that do not execute programming 
instructions if National Instruments receives notice of such defects during the warranty period. National Instruments does not 
warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of 
the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of 
returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed 
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to 
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader should consult 
National Instruments if errors are suspected. In no event shall National Instruments be liable for any damages arising out of 
or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL  INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY 
WARRANTY OF MERCHANTABILITY  OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’ S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR 
NEGLIGENCE ON THE PART OF NATIONAL  INSTRUMENTS SHALL BE LIMITED  TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL  
INSTRUMENTS WILL  NOT BE LIABLE  FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of National Instruments will 
apply regardless of the form of action, whether in contract or tort, including negligence. Any action against National Instruments 
must be brought within one year after the cause of action accrues. National Instruments shall not be liable for any delay in 
performance due to causes beyond its reasonable control. The warranty provided herein does not cover damages, defects, 
malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or 
maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or 
surges, fire, flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including 
photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written 
consent of National Instruments Corporation.

Trademarks
CVI™, LabVIEW™, National Instruments™, ni.com™ NI-488.2™, NI-DAQ™, NI-VISA™, and NI-VXI™ are trademarks of 
National Instruments Corporation.

FireWire is a trademark of Apple Computer, Inc. Product and company names mentioned herein are trademarks or trade names of 
their respective companies.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL 
OF RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL 
COMPONENTS IN ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE 
EXPECTED TO CAUSE SIGNIFICANT INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS 
CAN BE IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL 
POWER SUPPLY, COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE 
FITNESS, FITNESS OF COMPILERS AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, 
INSTALLATION ERRORS, SOFTWARE AND HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR 
FAILURES OF ELECTRONIC MONITORING OR CONTROL DEVICES, TRANSIENT FAILURES OF ELECTRONIC 
SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR MISUSES, OR ERRORS ON THE PART OF 
THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE HEREAFTER 
COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD 
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) 
SHOULD NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM 
FAILURE. TO AVOID DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE 
REASONABLY PRUDENT STEPS TO PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO 
BACK-UP OR SHUT DOWN MECHANISMS. BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS 
FROM NATIONAL INSTRUMENTS' TESTING PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER 
MAY USE NATIONAL INSTRUMENTS PRODUCTS IN COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT 
EVALUATED OR CONTEMPLATED BY NATIONAL INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS 
ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING THE SUITABILITY OF NATIONAL 
INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE INCORPORATED IN A 
SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, PROCESS AND 
SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



 Compliance

FCC/Canada Radio Frequency Interference Compliance*

Determining FCC Class
The Federal Communications Commission (FCC) has rules to protect wireless communications from interference. 
The FCC places digital electronics into two classes. These classes are known as Class A (for use in industrial-
commercial locations only) or Class B (for use in residential or commercial locations). Depending on where it is 
operated, this product could be subject to restrictions in the FCC rules. (In Canada, the Department of 
Communications (DOC), of Industry Canada, regulates wireless interference in much the same way.)

Digital electronics emit weak signals during normal operation that can affect radio, television, or other wireless 
products. By examining the product you purchased, you can determine the FCC Class and therefore which of the two 
FCC/DOC Warnings apply in the following sections. (Some products may not be labelled at all for FCC, if so the 
reader should then assume these are Class A devices.)

FCC Class A products only display a simple warning statement of one paragraph in length regarding interference and 
undesired operation. Most of our products are FCC Class A. The FCC rules have restrictions regarding the locations 
where FCC Class A products can be operated.

FCC Class B products display either a FCC ID code, starting with the letters EXN, 
or the FCC Class B compliance mark that appears as shown here on the right.

The curious reader can consult the FCC web site http://www.fcc.gov  for more 
information.

FCC/DOC Warnings
This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance with the 
instructions in this manual and the CE Mark Declaration of Conformity**, may cause interference to radio and 
television reception. Classification requirements are the same for the Federal Communications Commission (FCC) 
and the Canadian Department of Communications (DOC). 

Changes or modifications not expressly approved by National Instruments could void the user’s authority to operate 
the equipment under the FCC Rules.

Class A
Federal Communications Commission

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the 
equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to 
radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in 
which case the user will be required to correct the interference at his own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du 
Canada.

Class B
Federal Communications Commission

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful 



interference to radio or television reception, which can be determined by turning the equipment off and on, the user 
is encouraged to try to correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

Canadian Department of Communications
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du 
Canada.

European Union - Compliance to EEC Directives
Readers in the EU/EEC/EEA must refer to the Manufacturer's Declaration of Conformity (DoC) for information** 
pertaining to the CE Mark compliance scheme. The Manufacturer includes a DoC for most every hardware product 
except for those bought for OEMs, if also available from an original manufacturer that also markets in the EU, or 
where compliance is not required as for electrically benign apparatus or cables.

* Certain exemptions may apply in the USA, see FCC Rules §15.103 Exempted devices, and §15.105(c). Also 
available in sections of CFR 47.

** The CE Mark Declaration of Conformity will contain important supplementary information and instructions for 
the user or installer.
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About This Manual

This manual contains instructions for installing and configuring either of 
two National Instruments VXI-1394 kits:

• VXI-1394 interface kit for Windows 98 and Windows NT

• VXI-1394/G interface kit for Windows NT

The VXI-1394 kit is a low-cost, VXIplug&play-compliant IEEE 1394 
interface that gives external PCI-based computers the capabilities of 
embedded VXI controllers. The VXI-1394/G also adds the capabilities 
of a GPIB controller.

How To Use the Manual Set

Novice
Users

Experienced
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NI-488.2
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Development
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NI-488.2 Function
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This getting started manual contains an overview of the VXI-1394 
hardware, the NI-VXI/VISA software, and the NI-488.2 software, guides 
you through setting up your kit, and helps you get started with application 
development. You can also use this manual as a reference for the hardware 
and software default settings and to find the answers to commonly 
asked questions.

When you have successfully set up your system, you can begin to develop 
applications in NI-VXI, NI-VISA, and/or NI-488.2. Online manuals are 
included in your kit in the form of Adobe Acrobat version 3.0 portable 
document format (PDF) files. The NI-VXI User Manual presents the 
concepts of VXI and prepares you for detailed explanations of the NI-VXI 
functions. Study the descriptions of each function given in the online help 
utility to fully understand the purpose and syntax of each function.

The Acrobat manuals and their installed locations are as follows:

• The NI-VISA User Manual describes how to program using NI-VISA:
Start»Programs»VXIpnp»NI-VISA User Manual

• The NI-VISA Programmer Reference Manual describes in detail the 
attributes, events, and operations you use in NI-VISA:
Start»Programs»VXIpnp»NI-VISA Programmer 
Reference Manual

• The NI-VXI User Manual describes the features of NI-VXI:
Start»Programs»National Instruments VXI»NI-VXI User 
Manual

• The NI-VXI Programmer Reference Manual describes in detail the 
VXI/VME function calls in the C/C++ and BASIC languages:
Start»Programs»National Instruments VXI»NI-VXI 
Programmer Reference Manual

• Information about GPIB and NI-488.2 is available in the online help. 
Select Start»Programs»National Instruments NI-488.2»Explore 
GPIB. Then select Help»Help Topics.

Use the Acrobat Reader program, Version 3 or later, to open these files.

Note You can download Acrobat Reader from the Adobe Web site at www.adobe.com
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Conventions
The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

♦ The ♦ symbol indicates that the following text applies only to a specific 
product, a specific operating system, or a specific software version.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash.

bold Bold text denotes items that you must select or click on in the software, 
such as menu items and dialog box options. Bold text also denotes 
parameter names.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 
to a key concept. This font also denotes text that is a placeholder for a word 
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames and extensions, and code excerpts.

monospace bold Bold text in this font denotes the messages and responses that the computer 
automatically prints to the screen. This font also emphasizes lines of code 
that are different from the other examples.

monospace italic Italic text in this font denotes text that is a placeholder for a word or value 
that you must supply.

Platform Text in this font denotes a specific platform and indicates that the text 
following it applies only to that platform.
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Related Documentation
The following documents contain information that you may find helpful as 
you read this manual:

• ANSI/IEEE Standard 1014-1987, IEEE Standard for a Versatile 
Backplane Bus: VMEbus

• ANSI/IEEE Standard 1155-1998, IEEE VMEbus Extensions for 
Instrumentation: VXIbus

• ANSI/VITA 1-1994, VME64

• IEEE Standard 1394-1995, IEEE Standard for a High Performance 
Serial Bus

• PCI Local Bus Specification, Revision 2.1, PCI Special Interest Group

• VXI-6, VXIbus Mainframe Extender Specification, Rev. 2.0, VXIbus 
Consortium

• ANSI/IEEE Standard 488.1-1987, IEEE Standard Digital Interface 
for Programmable Instrumentation

• ANSI/IEEE Standard 488.2-1992, IEEE Standard Codes, Protocols, 
and Common Commands
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1
Introduction

This chapter describes your VXI-1394 interface kit, lists what you need 
to get started, and includes a brief description of the hardware and software.

The VXI-1394 interface kit links a PCI-based computer to the VXIbus 
using the IEEE 1394, or FireWire, high-speed serial bus. This kit makes 
your computer perform as though it were plugged directly into the VXI 
backplane, giving your external computer the capability of an embedded 
computer. You can connect streaming devices such as digital cameras to 
either the VXI-1394 interface in your VXI mainframe or the PCI-1394 
interface in your computer. IEEE 1394 features hot plug-in capability 
under Windows 98, which means you can add and configure 1394 devices 
without having to power down your system.

Your kit contains a National Instruments VXI-1394 interface module, 
which plugs into your VXI mainframe and links your computer to the 
VXIbus. The VXI-1394/G option adds a front panel connector for 
IEEE 488.2 devices so you can control a test system including both GPIB 
and VXI devices.

Your kit also contains an industry-standard OHCI host adapter, which links 
your PCI-based computer to the IEEE 1394 bus.

Note Windows 98 includes native support for the IEEE-1394 bus, but Windows NT 4 does 
not. National Instruments has developed a driver that works with the Adaptec AHA-8940 
PCI-1394 host adapter and various OHCI boards. If you are using Windows NT 4, you 
must use this driver, which may not be compatible with other 1394 host adapters or built-in 
1394 circuitry.

Your kit includes the NI-VXI/VISA bus interface software, which is fully 
VXI plug&play compliant. NI-VXI/VISA is the National Instruments 
implementation of the VISA I/O software standard on which all 
VXI plug&play software components are based.

If you ordered the VXI-1394/G, your kit also includes the 
industry-standard NI-488.2 software for GPIB communication.
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Note The front panel GPIB connector on the VXI-1394/G is not supported under 
Windows 98.

What You Need to Get Started
❑ A computer running either Windows NT 4 or Windows 98 

❑ An industry-standard OHCI host adapter

❑ VXIbus mainframe

❑ VXI-1394 interface module that plugs directly into a VXI mainframe

❑ 1394 cable

❑ National Instruments software CD

❑ This manual

❑ Windows 98 users — Windows 98 installation CD-ROM

VXI-1394 Interface Kit Overview
The interface kits described in this manual link a 1394-equipped computer 
directly to the VXIbus using the IEEE 1394 bus. The VXI-1394 kit uses 
this high-speed (up to 400 Mbits/s) serial bus to link your computer 
running Windows NT/98 to a VXI chassis.

Note You can connect multiple 1394 devices together in a tree topology. However, 
increasing the complexity of the 1394 bus topology can lower overall system performance.

Caution You cannot connect multiple 1394 devices in a circular bus topology (one which 
provides more than one data path between any two nodes). Doing so will render your 
VXI-1394 inoperable and may crash your system.

All VXI-1394 kits include the NI-VXI/VISA software for 
Windows NT/98, a C-size VXI-1394 module, a 1394 cable, and an 
industry-standard OHCI host adapter.

A 1394-equipped computer connected to a VXI-1394 interface can 
function as a VXI Commander and Resource Manager. The VXI-1394 
interface kit gives your computer the capability to perform as if it is plugged 
directly into the VXI backplane as an embedded CPU module. 
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The VXI-1394 transparently translates between the IEEE 1394 and VXI 
protocols.

A computer equipped with the VXI-1394/G can operate simultaneously 
as a GPIB Talker/Listener/Controller. The VXI-1394/G contains a 
TNT4882C single-chip IEEE 488.2 interface, which also implements the 
HS488 high-speed protocol, increasing the maximum GPIB data transfer 
rate up to 8 MB/s (depending on the system).

The software included with the kits is for x86/Pentium-based computers.

Hardware Description
The VXI-1394 module is a VXIbus device with optional VXIbus Slot 0 
capability so that it can reside in any slot in a C-size or D-size chassis. 
If you enable this capability, the VXI-1394 can automatically determine 
whether it is located in VXI Slot 0.

Note D-size VXI mainframes have connections for a P3 connector. The VXI-1394, 
however, does not have this connector and, if configured as a Slot 0 controller, cannot 
provide the necessary control for VXI devices that need P3 support.

Caution An improper Slot 0 setting may damage the VXI-1394 module and/or the VXI 
chassis.

The VXI-1394 links the computer to the VXIbus and converts 1394 data 
transfers into VXIbus data transfers and vice versa. The VXI-1394 includes 
additional 1394 ports you can use to connect other 1394 devices.

The VXI-1394/G version includes a front-panel GPIB port you can use 
to integrate GPIB devices into your VXI-based instrumentation system 
without the need of a GPIB adapter in the host computer. The standard 
VXI-1394 and VXI-1394/G are otherwise functionally equivalent. 
The GPIB port on the VXI-1394/G cannot be used to control the VXIbus; 
it is intended for controlling only GPIB instruments through either 
NI-488.2 or NI-VISA. With the VXI-1394/G, you can control both GPIB 
and VXI instruments using a single 1394 cable from your host computer.

The PCI-1394 is an industry-standard 1394 host adapter on a PCI board, 
which gives your computer the capability to control 1394 devices. The 
PCI-1394 also supplies power to the IEEE 1394 bus, which is required by 
some devices.



Chapter 1 Introduction

VXI-1394 Interface for Windows NT/98 1-4 www.ni.com

VXI-1394 Front Panel Features
The VXI-1394 has the following front panel features.

• Three front panel LEDs

– SYSFAIL  LED indicates that the VMEbus SYSFAIL line is 
asserted.

– 1394 LED indicates when the VXI-1394 is accessed from the 
IEEE 1394 bus.

– VXI  LED indicates when the VXI-1394 is accessed from the 
VXIbus.

• Three 1394 6-pin connectors

• GPIB connector (VXI-1394/G version only)

• Three SMB connectors

– External clock

– Trigger output

– Trigger input

• System reset push-button

Advanced Configuration Options
The default hardware configuration of the VXI-1394 should be acceptable 
for most systems. Refer to Appendix C, Advanced Hardware 
Configuration Settings, only if your system will make use of the front-panel 
CLK10 and trigger SMB connectors.

Software Description
NI-VXI is the name of the National Instruments VXI bus control library. 
You can create applications using NI-VXI to control both VXI and VME 
devices. NI-VXI gives you complete VXI/VME functionality, including 
an API for performing basic VXI/VME data transfers and handling 
VXI/VME interrupts as well as VXI-specific functionality, such as doing 
message-based communication and handling VXIbus triggers.

NI-VISA is the National Instruments implementation of the VISA 
specification. VISA is a uniform API for communicating with and 
controlling GPIB, VXI, and VME and Serial instruments. This API aids in 
the creation of more portable applications and instrument drivers.
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The NI-VXI/VISA software includes an interactive configuration and 
troubleshooting program, libraries of software routines for test and 
measurement (T&M) programming, interactive control programs for both 
NI-VXI and NI-VISA, a logging utility you can use for debugging your 
applications, and a VXI Resource Manager. You can use this software to 
seamlessly program multiple-mainframe configurations and have software 
compatibility across a variety of controller platforms.

If your VXI-1394 model is the VXI-1394/G, it includes a GPIB port on its 
front panel, as well as the National Instruments NI-488.2 software kit, 
NI-488.2 is industry-standard software for controlling external GPIB 
instruments. Any GPIB application using either NI-488.2 or NI-VISA will 
run on the VXI-1394/G. Use the GPIB Configuration Utility to examine or 
modify the configuration of the NI-488.2 software.

Note You must run the GPIB Configuration Utility before you use the NI-488.2 software 
for Windows NT. For more information, refer to Chapter 2, Installation and Configuration.

Once your GPIB board is configured you can access additional GPIB 
utilities and help through T&M Explorer. Use T&M Explorer to view your 
entire T&M system and configure various components, whether they are 
Serial, GPIB, VXI, or VME devices. It is easy to add VME devices using 
T&M Explorer and view them on a screen display along with the rest of 
your system. This utility also adopts the functionality of the NI-DAQ 
Configuration utility so you can configure National Instruments VXI-DAQ 
cards.

T&M Explorer also features various options of how to run the VXI 
Resource Manager (Resman). You can still execute Resman independently 
to configure your instruments after a power cycle, but you can also perform 
resource manager operations directly from T&M Explorer or configure it 
to run Resman automatically at Windows startup.

The NI Spy utility tracks the calls your application makes to National 
Instruments T&M drivers, including NI-VXI, NI-VISA, and NI-488.2. 
NI Spy helps you debug your application by clearly highlighting the 
functions that return errors. You can let NI Spy keep a log of your 
program’s calls to these drivers so that you can check them for errors 
at your convenience.
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National Instruments Application Software
In addition to the NI-VXI, NI-VISA, and NI-488.2 software, you can use 
the National Instruments LabVIEW and LabWindows/CVI application 
programs and instrument drivers to ease your programming task. These 
standardized programs match the modular virtual instrument capability of 
VXI and can reduce your VXI/VME software development time. These 
programs are fully VXIplug&play compliant and feature extensive libraries 
of VXI instrument drivers written to take full advantage of direct VXI 
control. LabVIEW and LabWindows/CVI include all the tools needed for 
instrument control, data acquisition, analysis, and presentation.

LabVIEW is a complete programming environment that departs from the 
sequential nature of traditional programming languages and features a 
graphical programming environment.

LabWindows/CVI is an interactive C development environment for 
building test and measurement and instrument control systems. It includes 
interactive code-generation tools and a graphical editor for building custom 
user interfaces.

If you want to use either of these application programs, install them prior 
to installing the NI-VXI, NI-VISA, and NI-488.2 software. You also get 
hundreds of complete instrument drivers, which are modular, source-code 
programs that handle the communication with your instrument to speed 
your application development.
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2
Installation and Configuration

This chapter explains how to set up your test system.

Installing the Software
Use the Setup program that came with your NI-VXI/VISA/488.2 software 
to install the entire software package or a software update, or to reinstall 
software in the event that your files were accidentally erased.

Note The front panel GPIB connector on the VXI-1394/G is not supported under 
Windows 98.

Some of the utilities rely on the LabWindows/CVI Run-Time Engine. This 
software is installed, if necessary, during the NI-VXI/VISA installation.

Depending on the type of installation you choose, you may need up 
to 20 MB of free space available on your hard drive to accommodate the 
NI-VXI, NI-VISA, and NI-488.2 software.

To be compliant with VXIplug&play specifications, a VXI controller must 
provide the VISA I/O driver library standardized by VXIplug&play. VISA 
ensures that your controller can run all VXIplug&play-compatible software 
now and in the future.

The NI-VISA software in this kit is compatible with the WINNT/GWINNT 
and WIN95/GWIN95 frameworks. With NI-VISA installed on your 
computer, you can run any VXIplug&play software that is compatible with 
these frameworks. This includes instrument drivers and executable soft 
front panel software that are included with VXIplug&play-compatible 
instruments from a variety of vendors.
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Install the NI-VXI, NI-VISA, and NI-488.2 Software
This section describes how to install the 32-bit NI-VXI, NI-VISA, and 
NI-488.2 software. Please carefully read these directions along with any 
messages on the screen before making your selections.

Note Only VXI-1394/G users will be installing NI-488.2 on their systems.

You can quit the Setup program at any time by pressing the Cancel button.

Setup is an interactive, self-guiding program that installs the NI-VXI, 
NI-VISA, and NI-488.2 software and configures your system to use the 
software with the VXI-1394. Follow these steps to perform the installation:

1. For the CD, select Start»Run and enter the following text, where X is 
your CD drive (usually D):

X:\setup.exe

and press <Enter>.

For the floppy kit, insert the first disk and select Start»Run... and enter 
the following text, where X is your floppy drive (usually A or B):

X:\setup.exe

and press <Enter>.

2. Click on the Next button at the Welcome screen to start the installation 
and accept the license agreement.

Note If Setup detects a 16-bit (DOS or Windows 3.x) version of the NI-VXI software, 
it prompts you to remove it. Setup will quit so you can uninstall the old software. If you 
have a previous 32-bit (Windows NT/98) version of the NI-VXI software installed, Setup 
installs the new version over the previous version.

Caution If you want to keep the manufacturer/model name tables or the VME device 
configuration from a previous installation, be sure to back them up before starting Setup. 
They are located in the TBL subdirectory of your NI-VXI directory.

3. Select the type of installation from the Installation Options screen:

• Express setup is the fastest and simplest installation option. This 
option installs all the software in default directories.

• Custom setup gives you more control over which driver 
components you want installed on your system. This option is 
recommended for advanced users.
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4. Select the version of the PCI-1394 you will be using. Select the default, 
3-port OHCI board, unless you are using a 2-port Adaptec 1394 board 
that came with a previous VXI-1394 kit.

5. After selecting the board, the Express setup completes without further 
questions. Follow the prompts if you select the Custom setup option. 
The final prompt displays the choices you made concerning 
applications, support, and destination directories. Click on the 
Next button. Confirm that you are ready to install and click Next again 
to begin the installation.

6. Setup now copies the necessary files to your hard drive and creates 
program icons.

Complete the Software Installation
1. Please review the information in any readme  files that Setup prompts 

you to read.

2. When the installation process completes, power off the system for the 
changes to take effect.

If you backed up the manufacturer and model name files, restore them to 
the TBL subdirectory of your NI-VXI directory before running T&M 
Explorer.

Configuring the Hardware (optional)
This section contains basic information about configuring your VXI-1394 
hardware. Because the default settings for your VXI-1394 hardware are 
acceptable for most typical applications, this section is optional.

Refer to Appendix B, Default Settings, for a complete listing of the 
hardware and software default settings. Refer to Appendix C, Advanced 
Hardware Configuration Settings, if you want information about other 
possible settings.

Use the T&M Explorer utility in NI-VXI/VISA to change any of the 
configuration settings for the VXI-1394. For information on the software, 
including optional settings, use T&M Explorer and its online help. Use the 
Windows Start menu to open the program group for either NI-VXI or 
NI-VISA (VXIpnp), launch T&M Explorer, and select Help»Help Topics.
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Installing the Hardware
This section summarizes how to install your VXI-1394 hardware. Your kit 
contains a VXI-1394 interface module and a PCI-1394 adapter board.

Caution To guard against electrostatic discharge, touch the antistatic plastic packages to 
a metal part of your computer or chassis before removing the boards from their packages. 
Your computer or chassis should be plugged in but powered off.

Figure 2-1 illustrates a system that includes an IEEE 1394-equipped 
computer, a VXI-1394/G, IEEE 1394 devices, and a GPIB instrument. 
Each 1394 device should have only one connection to the 1394 system.

Figure 2-1.  Typical VXI-1394 System
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Install Your PCI-1394 Interface Board
The following are general installation instructions:

1. Shut down and power off the computer.

2. Remove the computer chassis cover to expose the expansion slots and 
external access covers.

3. Select an available PCI slot in your computer. The slot you select 
should support bus mastering. Refer to your computer documentation 
to determine if the slot you select supports bus mastering.

4. Remove the corresponding expansion slot cover from the chassis.

5. Align the bus connector on the bottom of the host adapter with the 
PCI bus slot.

Figure 2-2.  Installing the PCI-1394 Host Adapter

6. Carefully press the host adapter into the slot.

7. Secure the host adapter bracket to the computer chassis with the screw 
from the removed expansion slot cover.
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Install Your VXI-1394 Interface Board
All kits contain a VXI-1394 interface module.

Install the VXI-1394 in Slot 0 of your VXI chassis by doing the following:

1. Turn off the power.

2. Insert the VXI-1394/G into the chassis in Slot 0. See Figure 2-1.

3. Turn on the power.

The VXI-1394 default configuration automatically detects whether it 
should be the VXI system controller. The VXI system controllers operate 
certain VXI lines as required for VXI systems. Verify that any other VXI 
devices with system controller capability that are located in the same 
chassis are not configured as system controller.

Caution Having more than one device configured as system controller can damage the 
VXI system.

For VXI systems that include VME devices, ensure that the VME devices 
are not configured in the upper 16 KB (starting from 0xC000) of the 
A16 address space. This region is reserved for VXI device configuration 
registers, which are used for initializing, configuring, and interacting with 
VXI devices. The VXI-1394 also uses this region for this purpose.

Note Also ensure that no VXI devices in your system are configured for logical address 0. 
This is the default configuration for the VXI-1394.

Connect Cables
Connect the IEEE 1394 cable to the PCI-1394 host adapter and to the 
VXI-1394, as shown in Figure 2-1 at the beginning of this section. You 
can use any available 1394 port for each device. The VXI-1394 has three 
external ports. The OHCI 1394 host adapter has three external ports.

You can connect any other 1394 devices to any available port on an existing 
device, but for best results minimize the number of levels in the tree 
topology. Adding to the number of levels in the tree degrades system 
performance.

Caution Do not cable devices to your 1394 system in such a way as to form a loop. Any 
device should have only one connection to the 1394 bus. An example of a loop would be a 
system containing a PCI-1394, a VXI-1394, and a device connected to both. Such a closed 
loop would break the 1394 system.
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Some 1394 devices require different cables than others. Your kit includes 
one 6-to-6-pin cable to link the VXI-1394 to your computer. Some other 
devices such as a video conferencing camera, for example, also require a 
6-to-6-pin cable for proper connection to the 1394 system. Many other 
devices such as camcorders, VCRs, and so on, take a 6-to-4-pin cable. 
If you have the VXI-1394/G option, use a GPIB cable to attach your GPIB 
instruments to the GPIB port on the VXI-1394/G.

Power on the System
1. Be sure all cables are connected securely.

2. Ensure that the VXI-1394 is turned on prior to starting the external 
computer.

3. Turn on the external computer.

4. (PC systems) If your system CMOS setup requires you to enable PCI 
bus parameters, do so at this time.

Note The PCI bus usually assigns IRQs and port addresses automatically. However, in 
some PC systems, you may need to manually edit the PCI bus parameters in your CMOS 
setup. Refer to your computer documentation for further instructions.

5. You can now turn on any external devices.

♦ Windows 98 users—When you power-on your computer after installing your 
hardware, Windows 98 will prompt you for the original Windows 98 CD 
for the IEEE 1394 host adapter drivers.

Software Configuration and Verification

VXI-1394/G Only — GPIB Configuration and Verification
Use the GPIB Getting Started Wizard to configure and verify the 
installation. Start the wizard by selecting Start»Programs»National 
Instruments NI-488.2»Getting Started Wizard. The wizard guides you 
through the necessary steps to first configure the software and then verify 
the NI-488.2 installation by using the Troubleshooting Wizard.

Note During configuration, the correct board type to select is VXI-1394/G.

All of the NI-488.2 utilities can be accessed through either Measurement & 
Automation Explorer (Start»Programs»National Instruments 
NI-488.2»Explore GPIB) or through the T&M Explorer 
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(Start»Programs»National Instruments VXI»T&M Explorer). T&M 
Explorer is the recommended way to access the utilities because it provides 
access to all of the NI-488.2, NI-VXI and NI-VISA utilities.

Run T&M Explorer and Resman
1. Run the T&M Explorer program. It prompts you to run Resman, the 

National Instruments Resource Manager. You must run Resman every 
time the chassis power is cycled so that your application can access 
devices in the VXI chassis. You can also configure T&M Explorer to 
run Resman automatically at every computer startup by selecting 
Tools»Options and clicking the Resource Manager tab.

2. After you run Resman, you are ready to use T&M Explorer to 
interactively configure the National Instruments hardware in your 
system. Use the right-click help for information about the various 
configuration options.

After you finish configuring the system through T&M Explorer, verify the 
configuration through one of the interactive control utilities. Use VIC under 
NI-VXI ( Start»Programs»National Instruments VXI»VIC) or VISAIC 
under NI-VISA (Start»Programs»VXIpnp»Win32 VISA Interactive 
Control ).
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3
Developing Your Application

This chapter discusses the software utilities you can use to start developing 
applications.

After installing and configuring your system, you can begin to develop your 
NI-VXI, NI-VISA, or NI-488.2 application software. Be sure to check the 
readme.txt  file for the latest application development notes and changes.

Your software includes several utilities to help you develop your system. 
These include T&M Explorer, Resman, NI Spy, VISAIC, and VIC. You can 
also access several examples to learn how to use NI-VISA, NI-VXI, or 
NI-488.2 for certain tasks. Each of these components assists you with one 
of four steps of development: configuration, device interaction, 
programming, and debugging.

After installation, you can access these utilities through the Windows Start 
menu. For the NI-VXI or NI-VISA, use the utilities under 
Start»Programs»VXIpnp» or Start»Programs»National 
Instruments VXI.  For NI-488.2, use Start»Programs»National 
Instruments NI-488.2»Explore GPIB for access to all of the development 
and debugging utilities for NI-488.2.

Configuration
The configuration utilities in your kit include Resman and T&M Explorer. 
Resman is the application that performs VXI Resource Manager functions 
as described in the VXIbus specification. Its most important functions 
include configuring all devices on the VXI backplane for operation and 
allocating memory for devices that request it. Use the GPIB Configuration 
utility to configure your GPIB controller.

Note Because power cycling resets all devices, run Resman to reconfigure them every 
time chassis power is cycled.
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T&M Explorer presents a graphical display of your entire test and 
measurement system to help you configure various components. When you 
launch T&M Explorer, you see all your VXI, GPIB, GPIB-VXI, and serial 
devices on the screen. You can add devices that cannot be detected 
dynamically by T&M Explorer through the Add Device Wizard in the 
Edit  menu. Such devices include VME devices, certain GPIB devices, and 
serial ports. You can view the properties (such as logical address, address 
space used, primary address, and so on) of each device by right-clicking on 
the device in the tree. When you view the properties of most National 
Instruments devices, you can configure the hardware settings directly in the 
property pages.

T&M Explorer and Resman are designed to work together. You can run the 
Resource Manager through T&M Explorer by either clicking on the 
Run Resource Manager button on the toolbar, or selecting 
Tools»VXI Resource Manager. From Tools»Options, you can also 
configure T&M Explorer to run Resman automatically when the computer 
boots up. Resman reports all errors that it finds in your system to T&M 
Explorer. When you view your system through T&M Explorer, you can 
easily spot any errors in your system that Resman found.

You can find more information about T&M Explorer by using its online 
help. From T&M Explorer, select Help»Help Topics.

Device Interaction
After Resman has detected and configured all VXI/VME devices, you can 
view specific information on each device in your system by using the T&M 
Explorer utility. This utility includes a System View, which contains a 
description for each device, including each VXI device’s logical address.

VISAIC and VIC
You can interact with your VXI/VME devices by using either the VIC or 
VISAIC utility (VIC for NI-VXI or VISAIC for NI-VISA). You can use 
these utilities to interactively control your VXI/VME devices without 
having to use a conventional programming language, LabVIEW, or 
LabWindows/CVI.

Note You can launch VIC or VISAIC from the Tools menu in T&M Explorer.

Try the following in VIC. In the Command entry field, type:

help vxiinreg
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This help file shows you the syntax for this command, which reads VXI 
device configuration registers. The first argument is a logical address, and 
the second is the offset of the VXI device configuration register to be read.

Type:

vxiinreg 0,0

The History  window shows the result of the command execution, such as:

Return Status (0): Success.

Value = 0xBFF6

If the value ends with FF6, you have successfully read the National 
Instruments manufacturer ID from the VXI-1394 ID register.

You may now want to read the configuration registers from other VXI 
devices in your system using the command vxiinreg . This command 
accesses only the upper 16 KB of A16 space. Try reading a register from 
each of the devices listed in the Connection View of T&M Explorer. In this 
way, you can verify that your VXI-1394 can access each of the devices in 
your VXI system successfully.

You can also access VXI and VME devices that are configured in A16, 
A24, and A32 address space by using the vxiin  or vxiout  commands. 
For more information regarding VIC operation and commands, refer to the 
VIC online help.

Alternatively, you can use VISAIC to interact with your VXI, VME, GPIB 
and serial devices. VISAIC lists the available devices, similar to what T&M 
Explorer displays. By double-clicking on a given device, you can open a 
VISA session and access the device through it. For more information 
regarding VISAIC, use the right-click help available from all panels.

NI-488.2 Interactive Control
You can use the NI-488.2 Interactive Control utility to enter NI-488 
functions and NI-488.2 routines interactively and see the values returned 
by the function calls. You can use the utility to do the following:

• Verify GPIB communication with your device quickly and easily

• Learn the NI-488 functions and NI-488.2 routines before you write 
your application

• Become familiar with the commands of your device
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• Receive data from your GPIB device

• Troubleshoot problems with your application

Advanced Communication
For advanced interactive communication with GPIB instruments, use the 
Interactive Control utility, as follows:

1. Select Start»Programs»National Instruments NI-488.2»Explore 
GPIB to start Measurement & Automation Explorer.

2. Expand the Devices and Interfaces directory by clicking on the + next 
to the folder.

3. Right-click on your GPIB interface and select Interactive Control 
from the drop-down menu that appears.

4. At the command prompt, type NI-488.2 API calls to communicate 
interactively with the your instrument. For example, you might use 
ibdev , ibclr , ibwrt , ibrd , and ibonl .

To view the online help for Interactive Control, type help  at the Interactive 
Control command prompt.

Programming with VXI and GPIB
National Instruments provides three different programming interfaces for 
accessing your instruments: NI-VISA, NI-VXI, and NI-488.2. NI-VISA is 
the National Instruments implementation of the VISA API as defined by 
the VXIplug&play standard. It is very useful in situations where you have 
different types of instruments in your system—such as VXI, VME, GPIB, 
and serial devices—because the NI-VISA functions have the same 
interface.

NI-VXI is the National Instruments proprietary interface for programming 
VXI/VME instruments. Both NI-VXI and NI-VISA grant you register-level 
access of VXI instruments as well as messaging capability to 
message-based devices. With either interface you can service asynchronous 
events, such as triggers and signals, and also assert them.

NI-488.2 is the National Instruments industry-standard implementation of 
the ANSI/IEEE Standards 488.1-1987 and 488.2-1992. The original GPIB 
(General Purpose Interface Bus) specification, known as ANSI/IEEE 
Standard 488.1-1987, describes a standard interface for communication 
between instruments and controllers from various vendors. It contains 
information about electrical, mechanical, and functional specifications. 
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The GPIB is a digital, 8-bit parallel communications interface with data 
transfer rates of 1 Mbytes/s and above. The bus supports one System 
Controller, usually a computer, and up to 14 additional instruments. The 
ANSI/IEEE Standard 488.2-1992 extends IEEE-488.1 by defining a bus 
communication protocol, a common set of data codes and formats, and a 
generic set of common device commands.

The best way to learn how to program with NI-VXI and NI-VISA is by 
reviewing the example programs included in your software. In the 
Examples  directory you will find examples for many different types of 
applications. If you are just getting started, you should first learn how to 
access registers with high-level calls and send messages with word serial 
functions. The NI-VXI examples are called VXIhigh.c  and VXIws.c . 
The NI-VISA examples of these tasks are called VISAhigh.c  and 
VISAws.c . Use the other examples as you try more advanced techniques. 
Consult the NI-VXI User Manual, the NI-VISA User Manual, or the GPIB 
online help for additional information on these topics.

Note The NI-VXI User Manual resides in the NIVXI \manuals  directory, and the 
NI-VISA User Manual is in the VXIpnp \ os \NIvisa\manuals  directory, where os  
would be either WinNT or Win95 . Use the Acrobat Reader program to open and navigate 
through the manuals. To access the GPIB online help, select Start»Programs»National 
Instruments NI-488.2»Explore GPIB, then choose Help»Help Topics.

Table 3-1 summarizes the topics addressed by the NI-VXI and NI-VISA 
example programs.

Table 3-1.  NI-VXI/VISA Examples

Coverage
NI-VXI 
Example

NI-VISA 
Example

Message-Based Access VXIws.c VISAws.c, 
ReadWrite.c

High-Level Register Access VXIhigh.c VISAhigh.c
HighReg.c

Low-Level Register Access VXIlow.c VISAlow.c
LowReg.c

Sharing Memory VXImem.c VISAmem.c
ShareSys.c
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Note T&M Explorer includes special settings that you must use for memory sharing. 
Consult the T&M Explorer online help for information on setting these up.

Additional Compiler Information
When building an application with NI-VISA, you must include "visa.h"  
in your source code. In addition, you should link in the appropriate import 
library for your compiler.

Note LabWindows/CVI automatically includes the VISA library if it is needed. 
You do not need to explicitly link to the VISA import library when using 
LabWindows/CVI.

For the Microsoft C/C++ environment, use the visa32.lib  in the 
VXIpnp \ os \lib\msc  directory. For the Borland C/C++ environment, use 
the visa32.lib  in the VXIpnp \ os \lib\bc  directory. For example, if 
you are using Microsoft C/C++ with Windows NT and have installed 
NI-VISA into the default directory, you would normally specify 
C:\VXIpnp\WinNT\lib\msc\visa32.lib .

When building an application with NI-VXI, you must include "nivxi.h"  
in your source code. In addition, you should link in the appropriate import 
library for your compiler.

Note LabWindows/CVI automatically includes the VXI library if it is needed. You do not 
need to explicitly link to the NI-VXI import library when using LabWindows/CVI.

For the Microsoft C/C++ environment, use the nivxint.lib  in the 
NIVXI \win32\msc  directory. For Borland C/C++, use the nivxint.lib  
in the NIVXI \win32\borlandc  directory. For example, if you are using 
Microsoft and have installed NI-VXI into the default directory, you would 
normally specify C:\NIVXI\msc\nivxint.lib .

Interrupt Handling VXIint.c VISAint.c
AsyncHan.c
SyncInte.c

Trigger Handling VXItrig.c VISAtrig.c
SyncTrig.c

Table 3-1.  NI-VXI/VISA Examples (Continued)

Coverage
NI-VXI 
Example

NI-VISA 
Example
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Refer to the documentation that came with your compiler package for 
detailed instructions about using the compiler and the various tools (linker, 
debugger, and so on). Your compiler documentation is an important and 
useful source of information for writing, compiling, and debugging 
C programs.

Shared Memory
The VXI-1394 supports sharing of onboard VXI-1394 RAM in VXI space. 
However, it does not support sharing of the local PC memory. Refer to 
T&M Explorer online help for more information.

Additional Software Notes 
This section describes additional software options you may want to 
consider.

Compatibility
NI-VXI applications that follow the guidelines documented in the NI-VXI 
User Manual will work with NI-VXI for the VXI-1394.

System Configuration Functions
The InitVXIlibrary() function has a new return value of 
INIT_RET_OK_RMERROR (2) . If this value is returned, it means “The 
NI-VXI library successfully initialized, but the Resource Manager has not 
been run successfully.” Always run the Resource Manager before using the 
NI-VXI library, even if you are using only VME.

Low-Level VXIbus Access Functions
Do not make any assumptions about the size and features of a window 
returned from MapVXIAddress() . You should use GetWindowRange() 

to determine the size of a window. The 32-bit value returned from 
GetContext()  and passed to SetContext()  has a new format. 
Applications that set the context bits directly for use in SetContext() 

may not be compatible with the new format for context. Because the MITE 
allows more flexible window mapping, extra bits have been added to this 
field to reflect these new features. Do not manipulate the context bits 
directly.
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High-Level VXIbus Access Functions
For best performance, keep the following in mind when using VXImove() :

• Make sure your buffers are 32-bit aligned.

• Transfer 32-bit data whenever possible.

• Using VXI/VME block access privileges significantly improves 
performance to devices that are capable of accepting block 
transfers.

• VXImove()  must lock the user buffer in memory on virtual 
memory systems, so locking the buffer yourself optimizes 
VXImove() .

• Because VXImove()  must build a scatter-gather list for the user 
buffer on paged memory systems, using a contiguous buffer 
optimizes VXImove() .

VXImove()  can also move blocks of data to and from a single VXI/VME 
address. This is commonly referred to as FIFO mode. For more 
information, refer to the NI-VXI Programmer Reference Manual.

Notes about VME Support
To use VME devices in your system, configure NI-VXI to see these devices 
by using the Add Device Wizard in T&M Explorer. VME devices with 
two blocks of memory in the same address space require two entries. You 
can also specify which interrupt levels the device uses. VXI and VME 
devices cannot share interrupt levels. You can then access the VME device 
from NI-VXI or NI-VISA just as you would a register-based VXI device, 
by specifying the address space and the offset from the base at which you 
have configured it. NI-VISA support for VME devices includes the register 
access operations (both high-level and low-level) and the block move 
operations, as well as the ability to receive interrupts.
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Debugging
National Instruments provides several useful utilities that can aid in 
identifying the causes of problems in your application. These utilities 
include NI Spy, VISAIC, VIC, and the NI-488.2 Troubleshooting Wizard.

NI Spy
NI Spy tracks the calls your application makes to National Instruments 
T&M drivers including NI-VISA, NI-VXI, and NI-488.2. This utility 
highlights functions that return errors, so you can quickly spot which 
functions failed during your development. NI Spy can log the calls your 
program makes to these drivers so you can check them for errors at your 
convenience.

VISAIC and VIC
You can also control your instruments interactively using VISAIC and 
VIC. You can use VISAIC to control and communicate with your 
instruments with NI-VISA without having to write a program. VIC gives 
you a similar environment that uses NI-VXI. These utilities are an excellent 
platform for quickly testing instruments and learning how to communicate 
with them.

Note VISAIC finds all VXI, VME, GPIB, and serial instruments in your system. 
VIC recognizes only VXI and VME instruments, not GPIB or serial instruments.

Refer to the online help for instructions on how to use VIC or VISAIC and 
to learn about their features. In VIC, click on the ? button (located next 
to the Go button) to get help for that page, or type help . You can also 
right-click on a component on the screen to access What’s This help. In 
VISAIC, you can right-click to reach What’s This help and function help.

NI-488.2 Troubleshooting Wizard
To troubleshoot NI-488.2 problems, run the NI-488.2 Troubleshooting 
Wizard:

1. Select Start»Programs»National Instruments NI-488.2»Explore 
GPIB.

2. Start the NI-488.2 Troubleshooting Wizard by choosing 
Help»Troubleshooting»NI-488.2 Troubleshooting Wizard.
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A
Specifications

This appendix lists the specifications for the VXI-1394 and 
VXI-1394/G modules.

Requirements
VXIbus configuration space................... 64 B

A24 or A32 space................................... Programmable
Default ............................................ None

Environmental
Temperature

Operating ......................................0 to 55 °C
Storage .........................................–20 to 70 °C

Relative humidity
Operating ........................................ 10% to 90% noncondensing
Storage ............................................ 5% to 95% noncondensing

EMI ........................................................ FCC Class A verified, EC verified

Functional shock

MIL-T-28800E Class 3 (30 g half-sine shock pulse)
Also meets IEC 60068-2-27

Random vibration

MIL-T-28800E, MIL-STD-810E Category 1

Operational .............................. 5 to 500 Hz, 0.3 grms

Non-operational ....................... 5 to 500 Hz, 2.4 grms
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Power Requirement
+5 V

Typical.............................................2.23 A
Maximum (fused) ............................7 A

–5.2 V

Typical.............................................176 mA
Maximum (fused) ............................1 A

–2 V

Typical.............................................89.5 mA
Maximum (fused) ............................1 A

+12 V

Typical.............................................750 µA
Maximum (fused) ............................1 A

Physical
Dimensions

Fully enclosed, shielded VXI C-size board
233.35 by 340 mm (9.187 by 13.386 in.)

Weight
VXI-1394.........................................1.11 kg (2.45 lb.)

(No DRAM installed)
VXI-1394/G.....................................1.15 kg (2.53 lb.)

(No DRAM installed)

I/O connectors
6-pin 1394........................................3
SMB.................................................3
GPIB (optional) ...............................1

Slot requirements ....................................Single VXI C-size slot

Compatibility ..........................................Fully compatible with
VXI specification

VXI keying class ....................................Class 1 TTL

MTBF .....................................................Contact factory
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IEEE 1394 Capability Descriptions
Speed support ......................................... 100, 200, 400 Mbits/s

Protocol support ..................................... Asynchronous Quadlet and Block

Data payload packet sizes ...................... Up to 2048 bytes

Asynchronous Target and Initiator

VMEbus Capability Codes
A32, A24, A16 (master)

VMEbus master A32, A24, and A16 addressing

A32, A24, A16 (slave)
VMEbus slave A32, A24, and A16 addressing

D64, D32, D16, D08(EO)  (master)
VMEbus master D64, D32, D16, and D08 data sizes

D64, D32, D16, D08(EO)  (slave)
VMEbus slave D64, D32, D16, and D08 data sizes

BLT, MBLT (master)
VMEbus master block and D64 transfers

BLT, MBLT (slave)
VMEbus slave block and D64 transfers

RMW (master)
VMEbus master read/modify/write transfers

RMW (slave)
VMEbus slave read/modify/write transfers

RETRY (master)
VMEbus master retry support

RETRY (slave)
VMEbus slave retry support

FSD
First slot detector

SCON
VMEbus System Controller (Automatic Detection)
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PRI, RRS
Prioritized or Round Robin Select arbiter

ROR, FAIR
Release on Request and FAIR bus requester

IH(7-1)
Interrupt handler for levels 7-1

I(7-1)
Interrupt requester for levels 7-1

D32, D16, D08(O) (Interrupt Handler)
VMEbus D32, D16, D08(O) interrupt handler

D32, D16, D08(O) (Interrupter)
VMEbus D32, D16, D08(O) interrupter

ROAK, RORA
Release on Acknowledge or Register Access interrupter

BTO(x)
VMEbus bus timer (programmable limit)

LOCK
Can lock the VMEbus for indivisible transfers



© National Instruments Corporation B-1 VXI-1394 Interface for Windows NT/98

B
Default Settings

This appendix summarizes the default settings for the hardware and 
software in the VXI-1394 kit. If you need more information about a 
particular setting, or if you want to try a different configuration, please refer 
to Appendix C, Advanced Hardware Configuration Settings, for your 
hardware reference and to the T&M Explorer online help for your software 
reference.

Note There are no hardware settings on the PCI-1394 board.

Hardware Settings

Table B-1.  VXI-1394 Hardware Default Settings

Hardware Component Default Setting

W1—VXIbus Slot 0/Non-Slot 0 Automatic detection

S6—VXIbus CLK10 source From onboard oscillator

S5—External trigger termination OFF: unterminated

S3—SMB CLK10 direction IN: receive CLK10 signal

S2—SMB CLK10 termination OFF: ignored

S4—Polarity of external SMB 
CLK10

Inverted

S7—Configuration EEPROM Do not load from factory setting

DRAM SIMMs installed Per customer order
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Software Settings

Table B-2.  T&M Explorer Device Tab Default Settings

Editor Field Default Setting

Logical address 0

Device class Message based

Size of Servant area 0

System interrupt level Disabled

Number of handlers 1

Number of interrupters 0

Table B-3.  T&M Explorer Shared Memory Tab Default Settings

Editor Field Default Setting

Memory sharing Don’t share memory

Shared RAM size A16—none
A24—256 B
A32—64 KB

Reserved physical memory 0

Lower half window byte swapping Disabled

Upper half window byte swappingDisabled

Map upper and lower halves at 
same PCI address

Disabled
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Table B-4.  T&M Explorer VXI Bus Tab Default Settings

Editor Field Default Setting

Bus timeout value 125 µs

VXI retry generation Enabled

Automatic retries Disabled

A24/A32 write posting Disabled

Transfer limit 256

Requester mode Release on Request

Request level 3

Fair requester Enabled

Bus arbitration mode Prioritized

Arbiter timeout Enabled
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C
Advanced Hardware 
Configuration Settings

This appendix describes the factory-default and alternate hardware 
configuration settings of the VXI-1394. The board is set at the factory 
for the most commonly used configuration. Use this appendix if you 
want to try a different hardware configuration, or if you would like more 
information on a particular setting. This information is intended for more 
advanced users.

Hardware Default Settings
The following hardware configuration settings are user configurable:

• VXIbus Slot 0/Non-Slot 0

• Configuration EEPROM

• VXIbus CLK10 routing

• Trigger input termination

Figure C-1 shows the factory-default settings of the user-configurable 
jumper and switches on the VXI-1394. The slot selection jumper and 
six switches are located in the corner of the board behind the front panel 
SMB connectors.

Note Do not attempt an alternate setting unless you are familiar with its purpose. 
In addition, do not reconfigure any switches or jumpers not described in this appendix 
unless directed by National Instruments support.
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Figure C-1.  VXI-1394 Default Configuration Settings

VXIbus Slot 0/Non-Slot 0
The VXI-1394 is configured at the factory to automatically detect if it is 
installed in Slot 0 of a VXIbus mainframe. With automatic Slot 0 detection, 
you can install the VXI-1394 into any VXIbus slot.

You can manually configure the VXI-1394 for either Slot 0 or Non-Slot 0 
operation by defeating the automatic-detection circuitry. Use the 
three-position jumper W1 to select automatic Slot 0 detection, Slot 0, or 
Non-Slot 0 operation. Figure C-2 shows these three settings.

Caution Do not install a device configured for Slot 0 into another slot without first 
reconfiguring it to either Non-Slot 0 or automatic configuration. Neglecting to do this 
could damage the device, the VXIbus backplane, or both.
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Note The setting of any switch shown with this pattern ( ) has no bearing on 
the configuration described in any of the following figures. For example, Figure C-2 
shows switch S7 merely because of its close proximity to W1.

Figure C-2.  VXIbus Slot Configuration

A. Automatic Slot 0 Detection (Default)

B. Manual Slot 0 Configuration

C. Manual Non-Slot 0 Configuration

Slot 0

Auto

Nonslot 0

W1

Slot 0

Auto

Nonslot 0

W1

Slot 0

Auto

Nonslot 0

W1

S7
Y N

LOAD FACTORY

S7
Y N

LOAD FACTORY

S7
Y N

LOAD FACTORY



Appendix C Advanced Hardware Configuration Settings

VXI-1394 Interface for Windows NT/98 C-4 www.ni.com

When the VXI-1394 is installed in Slot 0, it becomes the VXIbus System 
Controller. In this role, it has VXIbus Data Transfer Bus Arbiter circuitry 
that accepts bus requests on all four VXIbus request levels, prioritizes the 
requests, and grants the bus to the highest priority requester. As VXIbus 
System Controller, the VXI-1394 also uses an onboard 16 MHz oscillator 
to drive the 16 MHz VXIbus system clock.

As required by the VXIbus specification, the VXI-1394 drives the 10 MHz 
signal CLK10 on a differential ECL output when installed in Slot 0. When 
not installed in Slot 0, the VXI-1394 only receives the CLK10 signal.

Configuration EEPROM
The VXI-1394 has an onboard EEPROM, which stores default register 
values that are loaded at power-on. The EEPROM is divided into 
two halves—a factory-configuration half, and a user-configuration half. 
Both halves were factory configured with the same configuration values so 
you can modify the user-configurable half, while the factory-configured 
half stores a back-up of the default settings.

The Load Factory switch (switch S7) causes the VXI-1394 to boot off the 
factory-configured half instead of the user-modified settings. This is useful 
in the event that the user-configured half of the EEPROM becomes 
corrupted in such a way that the VXI-1394 boots to an unusable state.

Figure C-3 shows the configuration settings for EEPROM operation.

Figure C-3.  EEPROM Operation
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VXIbus CLK10 Routing
When the VXI-1394 is installed in Slot 0 of your mainframe, it supplies 
the VXIbus CLK10 signal. The VXI-1394 has four hardware switches that 
work together to control various aspects of CLK10 routing. Please read this 
section carefully and notice that if you change one switch, you may need to 
change another. This section includes several diagrams that show how to 
configure the four switches to accomplish various CLK10 configurations.

Conversely, the configuration of one switch may make the setting of 
another switch irrelevant. For example, only switches S3 and S4 are 
relevant if you install the VXI-1394 in a slot other than Slot 0. The drawings 
use the  pattern to depict switches that are either irrelevant or disabled 
for a particular CLK10 configuration.

Switch S5 uses this pattern in all of the CLK10 drawings. It deals with the 
external trigger input SMB and is discussed later in this appendix.

The VXI-1394 can use two different sources to generate the VXIbus 
CLK10 signal—an onboard oscillator or the external CLK SMB connector. 
Use switch S6 to select between these options. The VXI-1394 uses the 
onboard oscillator by default.

The VXI-1394 can also be configured to drive the external CLK SMB from 
the VXIbus CLK10 signal. Switch S3 controls whether the VXI-1394 
drives or receives the external CLK SMB. If you change the S3 setting to 
drive CLK10 out the external CLK10 SMB connector, do not set switch S6 
to receive the SMB CLK10 signal; instead use its default setting so that the 
onboard oscillator generates the signal.

You can use an additional switch, S4, to control the polarity of the external 
CLK SMB signal when S3 is configured to drive it. S4 is unused—its 
setting is irrelevant—when S3 is configured to receive the external CLK 
SMB signal.

When switch S3 is set so that the VXI-1394 receives the SMB CLK10 
signal, you have the option to add a 50 Ω termination to the signal by setting 
switch S2. S2 is unused—its setting is irrelevant—when S3 is configured 
to drive the external CLK SMB signal.
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Figure C-4 shows the default settings for the CLK10 switches. This 
configuration is as follows:

• CLK10 is generated from the onboard oscillator (S6).

• The CLK10 signal is not terminated (S2).

• The VXI-1394 receives the external CLK10 signal (S3).

• The polarity of the CLK10 signal (S4) is irrelevant when the VXI-1394 
receives the external CLK10 signal. However, it is configured to be 
inverted when the CLK10 SMB is used as output.

Figure C-4.  Receive External CLK SMB (Default)
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The configuration in Figure C-5 adds a 50 Ω termination to the signal by 
changing switch S2.

Figure C-5.  Receive External CLK SMB with 50 Ω Termination
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In Figures C-6 and C-7, switch S6 uses the alternate configuration to 
generate the VXIbus CLK10 signal. Instead of the onboard oscillator, the 
VXI-1394 generates from the external CLK SMB connector and drives to 
the backplane. You can choose whether to terminate the signal using S2. 
Polarity remains irrelevant to these configurations.

Figure C-6.  Receive External CLK SMB and Drive to the Backplane Unterminated
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Figure C-7.  Receive External CLK SMB with 50 Ω Termination 
and Drive to the Backplane

Figures C-8 and C-9 show two configurations for driving the external CLK 
SMB from the VXIbus CLK10 signal by changing switch S3 to its alternate 
setting. Switch S6 must be in its default position for these configurations. 
Signal termination is not an issue when driving the signal, so the position 
of S2 does not matter. The difference between these two configurations is 
whether to use inverted or non-inverted polarity when driving the signal.

EXT
CLK10

TERMINATE
Y N

SMB
TRIG TERM

OUT IN

NON INV

S2

S3

S4

S5

S6

Y N

CLK10 SOURCE
SMB ONBRD



Appendix C Advanced Hardware Configuration Settings

VXI-1394 Interface for Windows NT/98 C-10 www.ni.com

Figure C-8.  Drive Inverted External CLK SMB

Figure C-9.  Drive Non-Inverted External CLK SMB
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Trigger Input Termination
Located within the group of CLK10 switches is switch S5, which controls 
whether to put a 50Ω termination on the external trigger input SMB. 
Figure C-10A shows the default setting for a non-terminated trigger input 
SMB. Use the setting of Figure C-10B to terminate the trigger input SMB.

Figure C-10.  SMB Trigger Input Termination
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D
Common Questions

This appendix addresses common questions you may have about using the 
NI-VXI/VISA/488.2 software on the VXI-1394 platform.

Why won’t my VXI-1394 work with my 1394 host adapter or built-in 
1394 bus?

Windows 98 includes built-in support for 1394 based on the OHCI 
specification. OHCI is relatively new, so hardware from some 
manufacturers may not comply fully with the specification. The National 
Instruments PCI-1394, available separately or with the VXI-1394 kit, 
works with both the Windows 98 built-in support and Windows NT (using 
the driver included with your PCI-1394). Contact National Instruments for 
more information.

What does hot plugging mean in terms of IEEE 1394?

The concept of hot plugging in 1394 means that you can remove and 
insert 1394 cables without powering down your computer and devices. The 
1394 Plug and Play architecture is designed so that the host computer can 
recognize when to load and remove the appropriate drivers. However, 
notice that inserting or removing any 1394 cable results in an interrupt 
condition on all devices, which may adversely affect any applications using 
the VXI-1394 at that time. For that reason, we recommend closing all 
1394-related applications before changing your 1394 bus configuration, 
and running Resource Manager after adding any new 1394 devices to your 
system.

Does it matter whether I plug in a 1394 device to the PCI-1394 in my 
computer or to the VXI-1394 in my mainframe?

The only difference is the topology of the system. If your system consists 
of a PC connected to a VXI-1394 which is in turn connected to a digital 
camera, you can get the best performance by connecting a third peripheral 
to the VXI-1394 rather than to the PC or the digital camera. This restricts 
the maximum distance between any two nodes to two cable segments. 
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Connecting the third peripheral to either the PC or the digital camera would 
create a maximum distance of three cable segments between any two nodes.

Use only a tree topology to build your system. A closed loop is illegal, and 
will not work. For example, if you have a PCI-1394 and a VXI-1394 cabled 
together and you add direct connections from both of them to the same 
digital camera, you create a closed loop. A 1394 device should have only 
one connection to the 1394 system.

Can I control the VXI chassis through the GPIB port on the 
VXI-1394/G module?

You can control the VXI chassis only through the 1394 bus. The GPIB port 
is used only for controlling other GPIB devices.

Can I have both a PCI-MXI-2 and a PCI-1394 interface in the same 
computer?

Yes, but only one of them can be used. Depending on your version of the 
software, the NI-VXI software will recognize only one of the boards as 
your VXI interface.

Can I have both a PCI-GPIB and a VXI-1394/G in the same computer?

Yes. Just be sure to assign each board a unique name. For example, if the 
PCI-GPIB is listed as GPIB0, assign some other name (such as GPIB1) to 
the VXI-1394/G using the GPIB Configuration Utility.

Which 1394 adapters will work with the VXI-1394 and VXI-1394/G?

Windows 98 includes built-in support for 1394 based on the OHCI 
specification. The National Instruments PCI-1394 works with both the 
Windows 98 built-in support and provides an OHCI driver for Windows 
NT 4.0. Contact National Instruments for more information if you 
encounter compatibility issues with your host adapter.

I need more devices than can fit in one chassis. How can I expand my 
VXI-1394 system?

Although it is physically possible to plug in another VXI-1394, software 
does not currently support this option. The recommended strategy is to use 
a VXI-MXI-2, which follows the VXI-6 specification for mainframe 
extension. This extends full VXI functionality across multiple mainframes, 
including a common device address space and interframe triggering, 
interrupts, and bus mastering. Place a VXI-MXI-2 in the same frame as the 
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Slot 0 VXI-1394, and another VXI-MXI-2 in Slot 0 of the next mainframe. 
You can then fill up this mainframe with additional devices.

If you have additional GPIB devices to add to the system—such as a 
GPIB-VXI/C controller in Slot 0 of another VXI chassis—the VXI-1394/G 
comes with a built-in GPIB controller so that you can connect GPIB 
devices directly off the VXI-1394/G without the need for a GPIB controller 
in your host computer.

How can I determine the serial number and hardware revision of the 
VXI-1394 board? 

Run T&M Explorer and right-click on the name of the VXI-1394 board. 
Select Hardware Configuration , and the dialog box for the VXI-1394 
board is displayed. The title bar includes the serial number and hardware 
revision of the board.

What is Resman?

Resman is the name of the utility that performs the duties of a VXI 
Resource Manager as discussed in the VXIbus specification. When you 
set a National Instruments controller to Logical Address 0, you will at 
some point need to run Resman to configure your VXI instruments. 
If your controller uses a different (non-zero) logical address and is a 
message-based device, you need to start Resman before running it on 
the Logical Address 0 computer.

When do I need to run Resman?

Run Resman whenever you need to configure your VXI instruments. For 
example, if you power-cycle your VXI chassis, your instruments will be 
reset, and you will need to run Resman to configure them. You can get into 
trouble if you run Resman when your devices are not in a reset state. 
Therefore, if you have to run Resman after running it once, you should reset 
all of your VXI instruments.

You can perform resource manager operations from within T&M Explorer 
after you install the VXI-1394 and cable it to your computer. With the 
VXI-1394, you may need to run the Resman utility if you boot your 
computer before turning on your VXI chassis or if you power-cycle your 
VXI chassis while the external PC remains on. In these cases, the 
instruments would have been reset without the computer rebooting. 
You will need to run the Resman utility or configure your system in T&M 
Explorer to initialize your VXI system.
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Which NI-VXI utility program must I use to configure the VXI-1394? 

Use the T&M Explorer program to configure the VXI-1394. 
T&M Explorer is located in the NIVXI  and VXIpnp  program group folders.

Use the Measurement & Automation Explorer to configure your 
GPIB system.

Which NI-VXI utility program must I use to initialize the VXI-1394?

The VXI-1394 initializes itself at chassis power-up.

How do I handle VME devices?

Although there is no way to automatically detect VME devices in a system, 
you can add them easily through the Add Device Wizard in T&M 
Explorer. Through this procedure, you can reserve resources for each of 
your VME devices and configure T&M Explorer to show VME devices on 
the screen with all your other devices.

Which NI-VXI utility program must I use to perform startup Resource 
Manager operations?

Use the Resman program to perform startup Resource Manager operations. 
It is located in the NIVXI  directory. Resman uses the settings configured 
in T&M Explorer. It initializes your VXI/VMEbus system and stores the 
information that it collects in the RESMAN.TBL file in the TBL subdirectory 
of the NIVXI  directory.

You can also run Resource Manager operations from T&M Explorer. 
Through T&M Explorer, you can also configure Resman to run 
automatically at computer startup.

What can I do to make sure that my system is up and running?

The fastest method for testing the system is to run Resman. This program 
attempts to access memory in the upper A16 address space of each device 
in the system. If Resman does not report any problems, the VXI-1394 
communication system is operational.

To test individual devices, you can use the VIC or VISAIC program to 
interactively issue NI-VXI functions or NI-VISA operations, respectively. 
You can use the VXIin()  and VXIout()  functions or the VXIinReg()  
and VXIoutReg()  functions to test register-based devices by 
programming their registers. If you have any message-based devices, you 
can send and receive messages with the WSwrt()  and WSrd()  functions. 
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Notice that VXIinReg()  and VXIoutReg()  are for VXI devices only, but 
you can use VXIin()  and VXIout()  for both VXI and VME.

Finally, if you are using LabVIEW or LabWindows/CVI and you have 
instrument drivers for the devices in your chassis, you can use the 
interactive features of these programs to quickly test the functionality of 
the devices.

What should I do if I get a Configuration EEPROM is Invalid 

message?

There are several reasons why you might get the Configuration EEPROM 

is Invalid  message. If you turned off the VXI chassis while the 
configuration update process was still in progress, the board functions 
normally except when running T&M Explorer. To correct these problems, 
reboot the VXI chassis with the Load Factory switch set (as described in 
Appendix C, Advanced Hardware Configuration Settings) and update the 
configuration, or load the configuration from file.

What do the LEDs on the front of the VXI-1394 mean?

• The SYSFAIL  LED shows the state of the VXI/VMEbus SYSFAIL 
line. This line is asserted whenever any device in the chassis has not 
yet passed its self test, if it has failed its self test, or if it has detected a 
failure after originally passing its self test.

• The 1394 LED indicates that the VXI-1394 is being accessed by 
another device on the IEEE 1394 bus, such as when the computer 
communicates with either the VXI-1394 or another device in the 
chassis.

• The VXI LED, when lit, indicates that the VXI-1394 is being accessed 
by another device in the VXI chassis, such as when a bus master inside 
the chassis wants to talk to either the VXI-1394 or memory in the 
computer.

What kind of signal is CLK10 and what kind of signal do I need for an 
external CLK10?

CLK10 is a differential ECL signal on the VXIbus backplane. However, the 
oscillator for the VXI-1394 and the EXTCLK input from the front panel 
use TTL. Therefore, supply a TTL-level signal for EXTCLK, and our 
voltage converters will convert the signal to differential ECL.
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What is the accuracy of the CLK10 signal? 

The CLK10 generated by the VXI-1394 is 100 ppm (0.01%) as per the 
VXIbus specification. If you need a more accurate CLK10 signal, you can 
use the EXTCLK input at the front of the VXI-1394.

What is shared memory and dual-ported memory?

These terms refer to a block of memory that is accessible to both a client 
and a server. The memory block operates as a message buffer for 
communications. Shared memory is applicable only if you are using either 
A24 or A32 address space.
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E
Technical Support Resources

This appendix describes the comprehensive resources available to you in 
the Technical Support section of the National Instruments Web site and 
provides technical support telephone numbers for you to use if you have 
trouble connecting to our Web site or if you do not have internet access.

NI Web Support
To provide you with immediate answers and solutions 24 hours a day, 
365 days a year, National Instruments maintains extensive online technical 
support resources. They are available to you at no cost, are updated daily, 
and can be found in the Technical Support section of our Web site at 
www.ni.com/support

Online Problem-Solving and Diagnostic Resources
• KnowledgeBase—A searchable database containing thousands of 

frequently asked questions (FAQs) and their corresponding answers or 
solutions, including special sections devoted to our newest products. 
The database is updated daily in response to new customer experiences 
and feedback.

• Troubleshooting Wizards—Step-by-step guides lead you through 
common problems and answer questions about our entire product line. 
Wizards include screen shots that illustrate the steps being described 
and provide detailed information ranging from simple getting started 
instructions to advanced topics.

• Product Manuals—A comprehensive, searchable library of the latest 
editions of National Instruments hardware and software product 
manuals.

• Hardware Reference Database—A searchable database containing 
brief hardware descriptions, mechanical drawings, and helpful images 
of jumper settings and connector pinouts.

• Application Notes—A library with more than 100 short papers 
addressing specific topics such as creating and calling DLLs, 
developing your own instrument driver software, and porting 
applications between platforms and operating systems.
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Software-Related Resources
• Instrument Driver Network —A library with hundreds of instrument 

drivers for control of standalone instruments via GPIB, VXI, or serial 
interfaces. You also can submit a request for a particular instrument 
driver if it does not already appear in the library.

• Example Programs Database—A database with numerous, 
non-shipping example programs for National Instruments 
programming environments. You can use them to complement the 
example programs that are already included with National Instruments 
products.

• Software Library —A library with updates and patches to application 
software, links to the latest versions of driver software for National 
Instruments hardware products, and utility routines.

Worldwide Support
National Instruments has offices located around the globe. Many branch 
offices maintain a Web site to provide information on local services. You 
can access these Web sites from www.ni.com/worldwide

If you have trouble connecting to our Web site, please contact your local 
National Instruments office or the source from which you purchased your 
National Instruments product(s) to obtain support.

For telephone support in the United States, dial 512 795 8248. For 
telephone support outside the United States, contact your local branch 
office:

Australia 03 9879 5166, Austria 0662 45 79 90 0, Belgium 02 757 00 20, 
Brazil 011 284 5011, Canada (Calgary) 403 274 9391, 
Canada (Ontario) 905 785 0085, Canada (Québec) 514 694 8521, 
China 0755 3904939, Denmark 45 76 26 00, Finland 09 725 725 11, 
France 01 48 14 24 24, Germany 089 741 31 30, Greece 30 1 42 96 427, 
Hong Kong 2645 3186, India 91805275406, Israel 03 6120092, 
Italy 02 413091, Japan 03 5472 2970, Korea 02 596 7456, 
Mexico (D.F.) 5 280 7625, Mexico (Monterrey) 8 357 7695, 
Netherlands 0348 433466, Norway 32 27 73 00, Poland 48 22 528 94 06, 
Portugal 351 1 726 9011, Singapore 2265886, Spain 91 640 0085, 
Sweden 08 587 895 00, Switzerland 056 200 51 51, 
Taiwan 02 2377 1200, United Kingdom 01635 523545
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Glossary

Prefix Meaning Value

p- pico- 10–12

n- nano- 10–9

µ- micro- 10– 6

m- milli- 10–3

k- kilo- 103

M- mega- 106

G- giga- 109

t- tera- 1012

Symbols

° degrees

Ω ohms

A

A amperes

A16 space VXIbus address space equivalent to the VME 64 KB short address space. 
In VXI, the upper 16 KB of A16 space is allocated for use by VXI devices’ 
configuration registers. This 16 KB region is referred to as VXI 
configuration space.

A24 space VXIbus address space equivalent to the VME 16 MB standard address 
space.

A32 space VXIbus address space equivalent to the VME 4 GB extended address space.

address Character code that identifies a specific location (or series of locations) in 
memory. In VISA, it identifies a resource.
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address modifier One of six signals in the VMEbus specification used by VMEbus masters 
to indicate the address space in which a data transfer is to take place.

address space A set of 2n memory locations differentiated from other such sets in 
VXI/VMEbus systems by six addressing lines known as address modifiers. 
n is the number of address lines required to uniquely specify a byte location 
in a given space. Valid numbers for n are 16, 24, and 32. In VME/VXI, 
because there are six address modifiers, there are 64 possible address 
spaces.

ANSI American National Standards Institute

API Application Programming Interface—the direct interface that an end user 
sees when creating an application.

arbitration A process in which a potential bus master gains control over a particular 
bus.

asynchronous Not synchronized; not controlled by time signals. In IEEE 1394, 
specifically, this is the standard protocol for sending packets that require an 
acknowledgment. This guarantees data delivery. The NI-VXI/VISA drivers 
for 1394 use this protocol exclusively.

B

b Bit—one binary digit, either 0 or 1.

B Byte—eight related bits of data, an 8-bit binary number. Also used to 
denote the amount of memory required to store one byte of data.

backplane An assembly, typically a printed circuit board, with 96-pin connectors and 
signal paths that bus the connector pins. A C-size VXIbus system will have 
two sets of bused connectors called J1 and J2. A D-size VXIbus system will 
have three sets of bused connectors called J1, J2, and J3.

BERR* bus error signal

BIOS Basic Input/Output System. BIOS functions are the fundamental level 
of any PC or compatible computer. BIOS functions embody the basic 
operations needed for successful use of the computer’s hardware resources.
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block-mode transfer An uninterrupted transfer of data elements in which the master sources only 
the first address at the beginning of the cycle. The slave is then responsible 
for incrementing the address on subsequent transfers so that the next 
element is transferred to or from the proper storage location. A VME data 
transfer may have no more than 256 elements.

bus The group of conductors that interconnect individual circuitry in a 
computer. Typically, a bus is the expansion vehicle to which I/O or other 
devices are connected. Examples of buses include the ISA bus, PCI bus, 
VXI bus, and VME bus.

bus error An error that signals failed access to an address. Bus errors occur with 
low-level accesses to memory and usually involve hardware with bus 
mapping capabilities. For example, nonexistent memory, a nonexistent 
register, or an incorrect device access can cause a bus error.

bus master A device that is capable of requesting the Data Transfer Bus (DTB) for the 
purpose of accessing a slave device.

byte order How bytes are arranged within a word or how words are arranged within 
a longword. Motorola ordering stores the most significant byte (MSB) or 
word first, followed by the least significant byte (LSB) or word. Intel 
ordering stores the LSB or word first, followed by the MSB or word.

C

C Celsius

CLK10 A 10 MHz, ±100 ppm, individually buffered (to each module slot), 
differential ECL system clock that is sourced from Slot 0 of a VXIbus 
mainframe and distributed to Slots 1 through 12 on P2. It is distributed to 
each slot as a single-source, single-destination signal with a matched delay 
of under 8 ns.

CMOS Complementary Metal Oxide Semiconductor—a process used in making 
chips.
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Commander A message-based device that is also a bus master and can control one or 
more Servants.

configuration registers A set of registers through which the system can identify a module device 
type, model, manufacturer, address space, and memory requirements. To 
support automatic system and memory configuration, the VXI specification 
requires that all VXIbus devices have a set of such registers.

D

Data Transfer Bus DTB; one of four buses on the VMEbus backplane. The DTB is used by a 
bus master to transfer binary data between itself and a slave device.

DMA Direct Memory Access—a method by which data is transferred between 
devices and internal memory without intervention of the central processing 
unit. DMA is the fastest method of transferring data to/from computer 
memory.

DRAM Dynamic RAM (Random Access Memory)—storage that the computer 
must refresh at frequent intervals.

dynamic configuration A method of automatically assigning logical addresses to VXIbus devices 
at system startup or other configuration times.

dynamically configured 
device

A device that has its logical address assigned by the Resource Manager. a 
VXI device initially responds at Logical Address 255 when its MODID line 
is asserted. The Resource Manager subsequently assigns it a new logical 
address, to which the device responds until powered down.

E

ECL Emitter-Coupled Logic

EEPROM Electronically Erasable Programmable Read Only Memory—ROM that 
can be erased with an electrical signal and reprogrammed.

embedded controller An intelligent CPU (controller) interface plugged directly into the VXI 
backplane, giving it direct access to the VXIbus. It must have all of its 
required VXI interface capabilities built in.

EMC electromagnetic compliance
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EMI electromagnetic interference

external trigger A voltage pulse from an external source that triggers an event.

F

fair requester A VXIbus device that will not arbitrate for the VXIbus after releasing 
it until it detects the bus request signal inactive. This ensures that all 
requesting devices will be granted use of the bus.

FireWire An Apple trademark for the technology that came to be defined as 
IEEE 1394. See IEEE 1394.

G

g (1) grams
(2) a measure of acceleration equal to 9.8 m/s2

GPIB General Purpose Interface Bus (IEEE 488)

gRMS A measure of random vibration. The root mean square of acceleration 
levels in a random vibration test profile.

H

hex Hexadecimal—the numbering system with base 16, using the digits 0 to 9 
and letters A to F.

hot plug-in capability The ability, a feature in IEEE 1394, to add and remove devices to a 
computer while the computer is running and have the operating system 
automatically recognize the change.

Hz hertz; cycles per second

I

IDE Integrated Drive Electronics. Denotes the most common interface to the 
hard drive on PCs.
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IEC International Electrotechnical Commission. The IEC publishes 
internationally recognized standards. IEC 60068 contains information on 
environmental testing procedures and severities.

IEEE Institute of Electrical and Electronics Engineers

IEEE 1394 A cross-platform implementation of the high-speed serial data bus, defined 
by IEEE Standard 1394-1995, that can move large amounts of data between 
computers and peripheral devices. It features simplified cabling, hot 
swapping, and transfer speeds of up to 400 Mbits/s. IEEE 1394 also enables 
the connection of digital consumer products, including digital camcorders, 
digital video tapes, digital video disks, set-top boxes, and music systems, 
directly to a personal computer.

i.LINK A brand name initiated by Sony for digital consumer products using 
IEEE 1394. SeeIEEE 1394.

in. inches

I/O Input/output—the techniques, media, and devices used to achieve 
communication between machines and users.

instrument driver A set of routines designed to control a specific instrument or family of 
instruments, and any necessary related files for LabWindows/CVI or 
LabVIEW.

interrupt A means for a device to request service from another device; a computer 
signal indicating that the CPU should suspend its current task to service a 
designated activity.

interrupt handler A VMEbus functional module that detects interrupt requests generated by 
interrupters and responds to those requests by requesting status and identify 
information.

interrupt level The relative priority at which a device can interrupt.

IRQ* interrupt signal

isochronous Pertains to processes that require timing coordination to be successful, such 
as voice and digital video transmission. A sound or picture going from a 
peripheral computer device or across a network into a computer or 
television set needs to arrive at close to the same rate of data flow as the 
source. In IEEE 1394, this protocol is used for purposes such as feeding 
digital image data from a peripheral device (such as a video camera) to a 
display mechanism within a computer.
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K

K kilo—(1) the standard metric prefix for 1,000, or 103, used with units of 
measure such as volts, hertz, and meters; (2) the prefix for 1,024, or 210, 
used with B (byte) in quantifying data or computer memory.

L

logical address An 8-bit number that uniquely identifies each VXIbus device in a system. 
It defines the A16 register address of a device, and indicates Commander 
and Servant relationships.

M

m meters

M mega—(1) the standard metric prefix for 1 million or 106, when used with 
units of measure such as volts and hertz; (2) the prefix for 1,048,576, or 220, 
when used with B (byte) to quantify data or computer memory.

master A functional part of a VME/VXIbus device that initiates data transfers on 
the backplane. A transfer can be either a read or a write.

message-based
device

An intelligent device that implements the defined VXIbus registers and 
communication protocols. These devices are able to use Word Serial 
Protocol to communicate with one another through communication 
registers.

MODID Module ID lines—used in VXI to geographically locate boards and to 
dynamically configure boards.

MTBF Mean Time Between Failure

N

NI-488.2 or
NI-488.2M

The National Instruments industry-standard software for controlling 
GPIB instruments.

NI-DAQ The National Instruments industry-standard software for data acquisition 
instruments.
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NI-VISA The National Instruments implementation of the VISA standard; an 
interface-independent software that provides a unified programming 
interface for VXI, GPIB, and serial instruments.

NI-VXI The National Instruments bus interface software for VME/VXIbus 
systems.

Non-Slot 0 device A device configured for installation in any slot in a VXIbus mainframe 
other than Slot 0. Installing such a device into Slot 0 can damage the device, 
the VXIbus backplane, or both.

O

OHCI Open Host Controller Interface. Specification for the register set for a 1394 
controller card. This standard allows interoperability of software with 
controllers from different vendors.

P

PCI Peripheral Component Interconnect. The PCI bus is a high-performance 
32-bit or 64-bit bus with multiplexed address and data lines.

R

register-based device A Servant-only device that supports VXIbus configuration registers. 
Register-based devices are typically controlled by message-based devices 
via device-dependent register reads and writes.

Resman The name of the National Instruments Resource Manager in NI-VXI bus 
interface software. See Resource Manager.

Resource Manager A message-based Commander located at Logical Address 0, which 
provides configuration management services such as address map 
configuration, Commander and Servant mappings, and self-test and 
diagnostic management.

retry An acknowledge by a destination that signifies that the cycle did not 
complete and should be repeated.

RMS Root mean squared. See gRMS.
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S

s seconds

SIMM Single In-line Memory Module

slave A functional part of a VME/VXIbus device that detects data transfer cycles 
initiated by a VMEbus master and responds to the transfers when the 
address specifies one of the device’s registers.

Slot 0 device A device configured for installation in Slot 0 of a VXIbus mainframe. This 
device is unique in the VXIbus system in that it performs the VXI/VMEbus 
System Controller functions, including clock sourcing and arbitration for 
data transfers across the backplane. Installing such a device into any other 
slot can damage the device, the VXIbus backplane, or both.

SMB Sub Miniature Type B connector that features a snap coupling for fast 
connection.

statically configured 
device

A device whose logical address cannot be set through software; that is, it is 
not dynamically configurable.

streaming data Data that is structured and processed in a continuous flow, such as digital 
audio and video. In IEEE 1394, this is often sent with the isochronous 
protocol rather than the standard asynchronous protocol.

SYSFAIL A VMEbus signal that is used by a device to indicate an internal failure. 
A failed device asserts this line. In VXI, a device that fails also clears its 
PASSed bit in its Status register.

T

trigger Either TTL or ECL lines used for intermodule communication.

TTL Transistor-Transistor Logic

V

V volts 

VGA Video Graphics Array; the minimum video display standard for all PCs.
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VIC VXI Interactive Control program, a part of the NI-VXI bus interface 
software. Used to program VXI devices and develop and debug VXI 
application programs.

VISA Virtual Instrument Software Architecture. This is the general name given to 
VISA and its associated architecture.

VISAIC VISA Interactive Control program, a part of the NI-VISA software. Used to 
program devices and develop and debug application programs.

VITA VMEbus International Trade Association

VME Versa Module Eurocard or IEEE 1014

VMEbus System 
Controller

A device configured for installation in Slot 0 or a VXIbus mainframe or the 
first slot in a VMEbus chassis. This device is unique in the VMEbus system 
in that it performs the VMEbus System Controller functions, including 
clock sourcing and arbitration for data transfers across the backplane. 
Installing such a device into any other slot can damage the device, the 
VMEbus/VXIbus backplane, or both.

VXIbus VMEbus Extensions for Instrumentation

W

W watts

Word Serial Protocol The simplest required communication protocol supported by 
message-based devices in a VXIbus system. It utilizes the A16 
communication registers to transfer data using a simple polling 
handshake method.

write posting A mechanism that signifies that a device will immediately give a successful 
acknowledge to a write transfer and place the transfer in a local buffer. The 
device can then independently complete the write cycle to the destination.
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Index

Numerics
1394 6-pin connectors, 1-4
1394 LED, 1-4

A
additional compiler information, 3-6
advanced hardware configuration settings, C-1
application development, 3-1
application software, 1-6

C
cable your system (caution), 2-6
capability codes

VMEbus, A-3
capability descriptions

IEEE 1394, A-3
CLK10

routing, VXI bus, C-5
signal accuracy, D-6
signal type, D-5

CLK10 switches
default settings (figure), C-6
receive external with 50 ohm termination 

(figure), C-7
common questions, D-1

1394 adapters and the VXI-1394 and 
VXI-1394/G, D-2

Configuration EEPROM is Invalid message, 
D-5

controlling the VXI chassis, D-2
hot plug-in

and IEEE 1394, D-1
LEDs, definitions of, D-5
NI-VXI utility programs, D-4

PCI-GPIB and VXI-1394/G in the same 
computer, D-2

PCI-MXI-2 and PCI-1394 interfaces in the 
same computer, D-2

plugging in multiple peripherals, D-1
Resman, D-3

using, D-4
serial number and hardware revision of 

VXI-1394, D-3
shared memory and dual-ported memory, 

D-6
VME devices, D-4
VXI-1394 and 1394 host adapter, D-1
VXI-1394 system expansion, D-2

configuration, 2-1
advanced hardware settings, C-1
advanced options, 1-4, C-1
application development, 3-1
default settings, B-1
EEPROM, C-4
hardware, 2-3
setup, 2-1
VXI-1394 default configuration settings 

(figure), C-2
VXIbus slot configuration (figure), C-3

Configuration EEPROM is Invalid message, D-5
connectors, 1394 6-pin, 1-4

D
debugging, 3-9
default settings, B-1

CLK10 switches, C-6
hardware, 2-3, B-1
software, B-2

developing applications, 3-1
device interaction, 3-2
device tab default settings (table), B-2
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E
EEPROM

configuration, C-4
Configuration EEPROM is Invalid 

message, D-5
operation (figure), C-4

electrostatic discharge (caution), 2-4

F
front panel

LEDs, definitions of, D-5
front panel features, 1-4

G
getting started

what you need, 1-2
GPIB

configuration utility, 1-5
front panel port, 1-3

GPIB connector (VXI-1394/G version only), 
1-4

H
hardware

advanced configuration settings, C-1
default settings, B-1, C-1
description, 1-3
installing, 2-4
PCI-1394, 1-3

host adapter, D-2
hot plug-in

and IEEE 1394, D-1
definition of, 1-1

I
IEEE 1394

capability descriptions, A-3
installation, 2-1

L
LabVIEW

definition of, 1-6
LabWindows/CVI, 3-6

definition of, 1-6
LEDs

1394, 1-4
definitions of, D-5
SYSFAIL, 1-4
VXI, 1-4

M
multiple devices

connecting (note), (caution), 1-2

N
National Instruments application software, 1-6

LabVIEW, 1-6
LabWindows/CVI, 1-6

National Instruments Web support, E-1
NI Spy, 1-5, 3-9
NI-488.2, 3-4

installing, 2-2
troubleshooting wizard, 3-9

NI-VISA, 3-4
definition and functionality of, 1-4
installing, 2-2

NI-VXI, 3-4
building applications, 3-6
definition and functionality of, 1-4
installing, 2-2
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NI-VXI and NI-VISA, programming 
examples, 3-5

NI-VXI/VISA
bus interface software, 1-1

O
OHCI host adapter, 1-1, 1-2
online problem-solving and diagnostic 

resources, E-1
overview

VXI-1394 kit, 1-2

P
PCI-1394, 1-3

host adapter, installing, 2-5
interface board

installing, 2-5
programming

additional compiler information, 3-6
additional software notes, 3-7
debugging, 3-9
NI-VXI and NI-VISA examples, 3-5
software compatibility, 3-7
system configuration functions, 3-7
VXI and GPIB, 3-4
VXIbus access functions, 3-7

R
Resman, 1-5, 2-8

power cycling (note), 3-1
using, D-4

resource manager
See Resman.

restart system power, 2-7

S
setup, 2-1
shared memory, 3-7
shared memory tab default settings (table), 

B-2
slot 0/non-slot 0, C-2
slot configuration, VXI bus (figure), C-3
software

additional notes, 3-7
compatibility, 3-7
description, 1-4
development

reducing VXI/VME development 
time, 1-6

installation, 2-1, 2-2
installation (note), (caution), 2-2
system configuration functions, 3-7
VXIbus access functions, 3-7

software-related resources, E-2
specifications, A-1

environmental, A-1
physical, A-2
power requirement, A-1, A-2
requirements, A-1

SYSFAIL LED, 1-4
system controller, 2-6

T
T&M Explorer, 1-5, 2-3, 2-8, 3-6

device interaction, 3-2
device tab default settings (table), B-2
shared memory tab default settings 

(table), B-2
VXI bus tab default settings (table), B-3

technical support resources, E-1
telephone support, E-2
troubleshooting wizard (NI-488.2), 3-9
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U
user configurable settings, C-1

V
VISAIC and VIC, 3-2, 3-9
VME support, 3-8
VMEbus capability codes, A-3
VXI bus tab default settings (table), B-3
VXI LED, 1-4
VXI-1394

default configuration settings (figure), 
C-2

front panel features, 1-4
hardware default settings (table), B-1
interface board, installing, 2-6
interface kit overview, 1-2
module description, 1-3
specifications, A-1
system expansion, D-2
typical system setup (figure), 2-4

VXI-1394/G
and GPIB port, 1-5
specifications, A-1

VXIbus
CLK10 routing, C-5
slot 0/non-slot 0, C-2
slot configuration (figure), C-3

W
Web support from National Instruments

online problem-solving and diagnostic 
resources, E-1

software-related resources, E-2
Windows 98

and IEEE 1394 host adapter drivers, 2-7
Windows NT

drivers for, support (note), 1-1
worldwide technical support, E-2


	Getting Started with Your VXI-1394 Interface for Windows NT/98
	Support
	Worldwide Technical Support and Product Information
	National Instruments Corporate Headquarters
	Worldwide Offices

	Important Information
	Warranty
	Copyright
	Trademarks
	WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS

	Compliance
	Contents
	About This Manual
	How To Use the Manual Set
	Conventions
	Related Documentation

	Chapter 1 Introduction
	What You Need to Get Started
	VXI-1394 Interface Kit Overview
	Hardware Description
	VXI-1394 Front Panel Features
	Advanced Configuration Options

	Software Description
	National Instruments Application Software


	Chapter 2 Installation and Configuration
	Installing the Software
	Install the NI-VXI, NI-VISA, and NI-488.2 Software
	Complete the Software Installation

	Configuring the Hardware (optional)
	Installing the Hardware
	Install Your PCI-1394 Interface Board
	Install Your VXI-1394 Interface Board
	Connect Cables
	Power on the System

	Software Configuration and Verification
	VXI-1394/G Only — GPIB Configuration and Verification
	Run T&M Explorer and Resman


	Chapter 3 Developing Your Application
	Configuration
	Device Interaction
	VISAIC and VIC
	NI-488.2 Interactive Control
	Advanced Communication


	Programming with VXI and GPIB
	Additional Compiler Information
	Shared Memory
	Additional Software Notes
	Compatibility
	System Configuration Functions
	Low-Level VXIbus Access Functions
	High-Level VXIbus Access Functions

	Notes about VME Support

	Debugging
	NI Spy
	VISAIC and VIC
	NI-488.2 Troubleshooting Wizard


	Appendix A Specifications
	Appendix B Default Settings
	Appendix C Advanced Hardware Configuration Settings
	Appendix D Common Questions
	Appendix E Technical Support Resources
	Glossary
	Symbols
	A
	B
	C
	D-E
	F-I
	K-N
	O-R
	S-V
	W

	Index
	Numerics
	A-D
	E-N
	O-T
	U-W

	Figures
	Figure 2-1. Typical VXI-1394 System
	Figure 2-2. Installing the PCI-1394 Host Adapter
	Figure C-1. VXI-1394 Default Configuration Settings
	Figure C-2. VXIbus Slot Configuration
	Figure C-3. EEPROM Operation
	Figure C-4. Receive External CLK SMB (Default)
	Figure C-5. Receive External CLK SMB with 50 W Termination
	Figure C-6. Receive External CLK SMB and Drive to the Backplane Unterminated
	Figure C-7. Receive External CLK SMB with 50 W Termination and Drive to the Backplane
	Figure C-8. Drive Inverted External CLK SMB
	Figure C-9. Drive Non-Inverted External CLK SMB
	Figure C-10. SMB Trigger Input Termination

	Tables
	Table 3-1. NI-VXI/VISA Examples 
	Table B-1. VXI-1394 Hardware Default Settings 
	Table B-2. T&M Explorer Device Tab Default Settings 
	Table B-3. T&M Explorer Shared Memory Tab Default Settings 
	Table B-4. T&M Explorer VXI Bus Tab Default Settings 


